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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Number of Logic Elements/Cells 149000

Total RAM Bits 7014400

Number of I/O 586

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 1156-BBGA

Supplier Device Package 1156-FPBGA (35x35)
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Single, Dual and Pseudo-Dual Port Modes 
In all the sysMEM RAM modes the input data and address for the ports are registered at the input of the memory 
array. The output data of the memory is optionally registered at the output. 

EBR memory supports the following forms of write behavior for single port or dual port operation: 

1. Normal – Data on the output appears only during a read cycle. During a write cycle, the data (at the current 
address) does not appear on the output. This mode is supported for all data widths. 

2. Write Through – A copy of the input data appears at the output of the same port during a write cycle. This 
mode is supported for all data widths. 

3. Read-Before-Write (EA devices only) – When new data is written, the old content of the address appears at 
the output. This mode is supported for x9, x18, and x36 data widths.

Memory Core Reset 
The memory array in the EBR utilizes latches at the A and B output ports. These latches can be reset asynchro-
nously or synchronously. RSTA and RSTB are local signals, which reset the output latches associated with Port A 
and Port B, respectively. The Global Reset (GSRN) signal can reset both ports. The output data latches and asso-
ciated resets for both ports are as shown in Figure 2-22. 

Figure 2-22. Memory Core Reset

For further information on the sysMEM EBR block, please see the list of technical documentation at the end of this 
data sheet. 

sysDSP™ Slice
The LatticeECP3 family provides an enhanced sysDSP architecture, making it ideally suited for low-cost, high-per-
formance Digital Signal Processing (DSP) applications. Typical functions used in these applications are Finite 
Impulse Response (FIR) filters, Fast Fourier Transforms (FFT) functions, Correlators, Reed-Solomon/Turbo/Convo-
lution encoders and decoders. These complex signal processing functions use similar building blocks such as mul-
tiply-adders and multiply-accumulators. 

sysDSP Slice Approach Compared to General DSP
Conventional general-purpose DSP chips typically contain one to four (Multiply and Accumulate) MAC units with 
fixed data-width multipliers; this leads to limited parallelism and limited throughput. Their throughput is increased by 
higher clock speeds. The LatticeECP3, on the other hand, has many DSP slices that support different data widths. 
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This allows designers to use highly parallel implementations of DSP functions. Designers can optimize DSP perfor-
mance vs. area by choosing appropriate levels of parallelism. Figure 2-23 compares the fully serial implementation 
to the mixed parallel and serial implementation. 

Figure 2-23. Comparison of General DSP and LatticeECP3 Approaches

LatticeECP3 sysDSP Slice Architecture Features
The LatticeECP3 sysDSP Slice has been significantly enhanced to provide functions needed for advanced pro-
cessing applications. These enhancements provide improved flexibility and resource utilization.

The LatticeECP3 sysDSP Slice supports many functions that include the following:

• Multiply (one 18 x 36, two 18 x 18 or four 9 x 9 Multiplies per Slice)

• Multiply (36 x 36 by cascading across two sysDSP slices)

• Multiply Accumulate (up to 18 x 36 Multipliers feeding an Accumulator that can have up to 54-bit resolution)

• Two Multiplies feeding one Accumulate per cycle for increased processing with lower latency (two 18 x 18 Mul-
tiplies feed into an accumulator that can accumulate up to 52 bits)

• Flexible saturation and rounding options to satisfy a diverse set of applications situations

• Flexible cascading across DSP slices
—  Minimizes fabric use for common DSP and ALU functions
—  Enables implementation of FIR Filter or similar structures using dedicated sysDSP slice resources only
—  Provides matching pipeline registers
—  Can be configured to continue cascading from one row of sysDSP slices to another for longer cascade 

chains

• Flexible and Powerful Arithmetic Logic Unit (ALU) Supports:
—  Dynamically selectable ALU OPCODE
—  Ternary arithmetic (addition/subtraction of three inputs)
—  Bit-wise two-input logic operations (AND, OR, NAND, NOR, XOR and XNOR)
—  Eight flexible and programmable ALU flags that can be used for multiple pattern detection scenarios, such 
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ALU Flags
The sysDSP slice provides a number of flags from the ALU including:

• Equal to zero (EQZ)

• Equal to zero with mask (EQZM)

• Equal to one with mask (EQOM)

• Equal to pattern with mask (EQPAT)

• Equal to bit inverted pattern with mask (EQPATB)

• Accumulator Overflow (OVER)

• Accumulator Underflow (UNDER)

• Either over or under flow supporting LatticeECP2 legacy designs (OVERUNDER)

Clock, Clock Enable and Reset Resources
Global Clock, Clock Enable and Reset signals from routing are available to every sysDSP slice. From four clock 
sources (CLK0, CLK1, CLK2, and CLK3) one clock is selected for each input register, pipeline register and output 
register. Similarly Clock Enable (CE) and Reset (RST) are selected at each input register, pipeline register and out-
put register.

Resources Available in the LatticeECP3 Family 
Table 2-9 shows the maximum number of multipliers for each member of the LatticeECP3 family. Table 2-10 shows 
the maximum available EBR RAM Blocks in each LatticeECP3 device. EBR blocks, together with Distributed RAM 
can be used to store variables locally for fast DSP operations. 

Table 2-9. Maximum Number of DSP Slices in the LatticeECP3 Family 

Table 2-10. Embedded SRAM in the LatticeECP3 Family

Device DSP Slices 9x9 Multiplier 18x18 Multiplier 36x36 Multiplier 

ECP3-17 12 48 24 6

ECP3-35 32 128 64 16

ECP3-70 64 256 128 32

ECP3-95 64 256 128 32

ECP3-150 160 640 320 80

Device EBR SRAM Block 
Total EBR SRAM 

(Kbits) 

ECP3-17 38 700

ECP3-35 72 1327

ECP3-70 240 4420

ECP3-95 240 4420

ECP3-150 372 6850
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Control Logic Block 
The control logic block allows the selection and modification of control signals for use in the PIO block. 

DDR Memory Support 
Certain PICs have additional circuitry to allow the implementation of high-speed source synchronous and DDR, 
DDR2 and DDR3 memory interfaces. The support varies by the edge of the device as detailed below.

Left and Right Edges
The left and right sides of the PIC have fully functional elements supporting DDR, DDR2, and DDR3 memory inter-
faces. One of every 12 PIOs supports the dedicated DQS pins with the DQS control logic block. Figure 2-35 shows 
the DQS bus spanning 11 I/O pins. Two of every 12 PIOs support the dedicated DQS and DQS# pins with the DQS 
control logic block.

Bottom Edge
PICs on the bottom edge of the device do not support DDR memory and Generic DDR interfaces. 

Top Edge
PICs on the top side are similar to the PIO elements on the left and right sides but do not support gearing on the 
output registers. Hence, the modes to support output/tristate DDR3 memory are removed on the top side.

The exact DQS pins are shown in a dual function in the Logic Signal Connections table in this data sheet. Addi-
tional detail is provided in the Signal Descriptions table. The DQS signal from the bus is used to strobe the DDR 
data from the memory into input register blocks. Interfaces on the left, right and top edges are designed for DDR 
memories that support 10 bits of data.

Figure 2-35. DQS Grouping on the Left, Right and Top Edges
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2. Left and Right (Banks 2, 3, 6 and 7) sysI/O Buffer Pairs (50% Differential and 100% Single-Ended Out-
puts)
The sysI/O buffer pairs in the left and right banks of the device consist of two single-ended output drivers, two 
sets of single-ended input buffers (both ratioed and referenced) and one differential output driver. One of the 
referenced input buffers can also be configured as a differential input. In these banks the two pads in the pair 
are described as “true” and “comp”, where the true pad is associated with the positive side of the differential I/O, 
and the comp (complementary) pad is associated with the negative side of the differential I/O. 

In addition, programmable on-chip input termination (parallel or differential, static or dynamic) is supported on 
these sides, which is required for DDR3 interface. However, there is no support for hot-socketing for the I/O 
pins located on the left and right side of the device as the PCI clamp is always enabled on these pins.

LVDS, RSDS, PPLVDS and Mini-LVDS differential output drivers are available on 50% of the buffer pairs on the 
left and right banks. 

3. Configuration Bank sysI/O Buffer Pairs (Single-Ended Outputs, Only on Shared Pins When Not Used by 
Configuration)
The sysI/O buffers in the Configuration Bank consist of ratioed single-ended output drivers and single-ended 
input buffers. This bank does not support PCI clamp like the other banks on the top, left, and right sides. 

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

Programmable PCI clamps are only available on the top banks. PCI clamps are used primarily on inputs and bi-
directional pads to reduce ringing on the receiving end.

Typical sysI/O I/O Behavior During Power-up 
The internal power-on-reset (POR) signal is deactivated when VCC, VCCIO8 and VCCAUX have reached satisfactory 
levels. After the POR signal is deactivated, the FPGA core logic becomes active. It is the user’s responsibility to 
ensure that all other VCCIO banks are active with valid input logic levels to properly control the output logic states of 
all the I/O banks that are critical to the application. For more information about controlling the output logic state with 
valid input logic levels during power-up in LatticeECP3 devices, see the list of technical documentation at the end 
of this data sheet. 

The VCC and VCCAUX supply the power to the FPGA core fabric, whereas the VCCIO supplies power to the I/O buf-
fers. In order to simplify system design while providing consistent and predictable I/O behavior, it is recommended 
that the I/O buffers be powered-up prior to the FPGA core fabric. VCCIO supplies should be powered-up before or 
together with the VCC and VCCAUX supplies. 

Supported sysI/O Standards 
The LatticeECP3 sysI/O buffer supports both single-ended and differential standards. Single-ended standards can 
be further subdivided into LVCMOS, LVTTL and other standards. The buffers support the LVTTL, LVCMOS 1.2 V, 
1.5 V, 1.8 V, 2.5 V and 3.3 V standards. In the LVCMOS and LVTTL modes, the buffer has individual configuration 
options for drive strength, slew rates, bus maintenance (weak pull-up, weak pull-down, or a bus-keeper latch) and 
open drain. Other single-ended standards supported include SSTL and HSTL. Differential standards supported 
include LVDS, BLVDS, LVPECL, MLVDS, RSDS, Mini-LVDS, PPLVDS (point-to-point LVDS), TRLVDS (Transition 
Reduced LVDS), differential SSTL and differential HSTL. For further information on utilizing the sysI/O buffer to 
support a variety of standards please see TN1177, LatticeECP3 sysIO Usage Guide. 

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
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SERDES Power Supply Requirements1, 2, 3

Over Recommended Operating Conditions

Symbol Description Typ. Max. Units

Standby (Power Down)

ICCA-SB VCCA current (per channel) 3 5 mA

ICCIB-SB Input buffer current (per channel) — — mA

ICCOB-SB Output buffer current (per channel) — — mA

Operating (Data Rate = 3.2 Gbps)

ICCA-OP VCCA current (per channel) 68 77 mA

ICCIB-OP Input buffer current (per channel) 5 7 mA

ICCOB-OP Output buffer current (per channel) 19 25 mA

Operating (Data Rate = 2.5 Gbps)

ICCA-OP VCCA current (per channel) 66 76 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 15 18 mA

Operating (Data Rate = 1.25 Gbps)

ICCA-OP VCCA current (per channel) 62 72 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 15 18 mA

Operating (Data Rate = 250 Mbps)

ICCA-OP VCCA current (per channel) 55 65 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 14 17 mA

Operating (Data Rate = 150 Mbps)

ICCA-OP VCCA current (per channel) 55 65 mA

ICCIB-OP Input buffer current (per channel) 4 5 mA

ICCOB-OP Output buffer current (per channel) 14 17 mA

1. Equalization enabled, pre-emphasis disabled.
2. One quarter of the total quad power (includes contribution from common circuits, all channels in the quad operating, 

pre-emphasis disabled, equalization enabled).
3. Pre-emphasis adds 20 mA to ICCA-OP data.
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LVDS25E
The top and bottom sides of LatticeECP3 devices support LVDS outputs via emulated complementary LVCMOS 
outputs in conjunction with a parallel resistor across the driver outputs. The scheme shown in Figure 3-1 is one 
possible solution for point-to-point signals.

Figure 3-1. LVDS25E Output Termination Example

Table 3-1. LVDS25E DC Conditions

LVCMOS33D
All I/O banks support emulated differential I/O using the LVCMOS33D I/O type. This option, along with the external 
resistor network, provides the system designer the flexibility to place differential outputs on an I/O bank with 3.3 V 
VCCIO. The default drive current for LVCMOS33D output is 12 mA with the option to change the device strength to 
4 mA, 8 mA, 16 mA or 20 mA. Follow the LVCMOS33 specifications for the DC characteristics of the LVCMOS33D.

Parameter  Description Typical Units

VCCIO Output Driver Supply (+/–5%) 2.50 V

ZOUT Driver Impedance 20 

RS Driver Series Resistor (+/–1%) 158 

RP Driver Parallel Resistor (+/–1%) 140 

RT Receiver Termination (+/–1%) 100 

VOH Output High Voltage 1.43 V

VOL Output Low Voltage 1.07 V

VOD Output Differential Voltage 0.35 V

VCM Output Common Mode Voltage 1.25 V

ZBACK Back Impedance 100.5 

IDC DC Output Current 6.03 mA

+ 
- 

RS=158 Ohms
(±1%)

RS=158 Ohms
(±1%)

RP = 140 Ohms
(±1%)

RT = 100 Ohms
(±1%)

OFF-chip 

Transmission line, Zo = 100 Ohm differential 

VCCIO = 2.5 V (±5%)

8 mA

VCCIO = 2.5 V (±5%)

ON-chip OFF-chip ON-chip

8 mA
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BLVDS25
The LatticeECP3 devices support the BLVDS standard. This standard is emulated using complementary LVCMOS 
outputs in conjunction with a parallel external resistor across the driver outputs. BLVDS is intended for use when 
multi-drop and bi-directional multi-point differential signaling is required. The scheme shown in Figure 3-2 is one 
possible solution for bi-directional multi-point differential signals.

Figure 3-2. BLVDS25 Multi-point Output Example

Table 3-2. BLVDS25 DC Conditions1

Over Recommended Operating Conditions

Parameter Description

Typical

UnitsZo = 45 Zo = 90

VCCIO Output Driver Supply (+/– 5%) 2.50 2.50 V

ZOUT Driver Impedance 10.00 10.00 

RS Driver Series Resistor (+/– 1%) 90.00 90.00 

RTL Driver Parallel Resistor (+/– 1%) 45.00 90.00 

RTR Receiver Termination (+/– 1%) 45.00 90.00 

VOH Output High Voltage 1.38 1.48 V

VOL Output Low Voltage 1.12 1.02 V

VOD Output Differential Voltage 0.25 0.46 V

VCM Output Common Mode Voltage 1.25 1.25 V

IDC DC Output Current 11.24 10.20 mA

1. For input buffer, see LVDS table.

Heavily loaded backplane, effective Zo ~ 45 to 90 Ohms differential

2.5 V

RTL RTR

RS = 90 Ohms
RS = 90 Ohms RS = 

90 Ohms

RS = 
90 Ohms RS = 

90 Ohms

RS = 
90 Ohms

RS = 
90 Ohms

RS = 
90 Ohms

45-90 
Ohms

45-90 
Ohms

2.5 V

2.5 V

2.5 V 2.5 V 2.5 V 2.5 V

2.5 V

+
–

. . .
+ –

. . .
+
–

+ –

16 mA

16 mA

16 mA 16 mA 16 mA 16 mA

16 mA

16 mA
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Generic DDRX2 Inputs with Clock and Data (>10bits wide) are Aligned at Pin (GDDRX2_RX.ECLK.Aligned)  
(No CLKDIV)

Left and Right Sides Using DLLCLKPIN for Clock Input

tDVACLKGDDR Data Setup Before CLK ECP3-150EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-150EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-150EA — 460 — 385 — 345 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-70EA/95EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-70EA/95EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-70EA/95EA — 460 — 385 — 311 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-35EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-35EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-35EA — 460 — 385 — 311 MHz

tDVACLKGDDR
Data Setup Before CLK 
(Left and Right Sides) ECP3-17EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-17EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-17EA — 460 — 385 — 311 MHz

Top Side Using PCLK Pin for Clock Input

tDVACLKGDDR Data Setup Before CLK ECP3-150EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-150EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-150EA — 235 — 170 — 130 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-70EA/95EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-70EA/95EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-70EA/95EA — 235 — 170 — 130 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-35EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-35EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-35EA — 235 — 170 — 130 MHz

tDVACLKGDDR Data Setup Before CLK      ECP3-17EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-17EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-17EA — 235 — 170 — 130 MHz

Generic DDRX2 Inputs with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX2_RX.DQS.Centered)  Using DQS Pin for Clock 
Input

Left and Right Sides

tSUGDDR Data Setup Before CLK All ECP3EA Devices 330 — 330 — 352 — ps

tHOGDDR Data Hold After CLK All ECP3EA Devices 330 — 330 — 352 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

Generic DDRX2 Inputs with Clock and Data (<10 Bits Wide) Aligned at Pin (GDDRX2_RX.DQS.Aligned) Using DQS Pin for Clock Input

Left and Right Sides

tDVACLKGDDR Data Setup Before CLK All ECP3EA Devices — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK All ECP3EA Devices 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

Generic DDRX1 Output with Clock and Data (>10 Bits Wide) Centered at Pin (GDDRX1_TX.SCLK.Centered)10

tDVBGDDR Data Valid Before CLK ECP3-150EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-150EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-70EA/95EA 666 — 665 — 664 — ps

tDVAGDDR Data Valid After CLK ECP3-70EA/95EA 666 — 665 — 664 — ps

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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Figure 3-11. Write Through (SP Read/Write on Port A, Input Registers Only)

Note: Input data and address are registered at the positive edge of the clock and output data appears after the positive edge of the clock.
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RSDS25 RSDS, VCCIO = 2.5 V –0.07 –0.04 –0.01 ns

PPLVDS Point-to-Point LVDS, True LVDS, VCCIO = 2.5 V or 3.3 V –0.22 –0.19 –0.16 ns

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 0.67 0.76 0.86 ns

HSTL18_I HSTL_18 class I 8mA drive, VCCIO = 1.8 V 1.20 1.34 1.47 ns

HSTL18_II HSTL_18 class II, VCCIO = 1.8 V 0.89 1.00 1.11 ns

HSTL18D_I Differential HSTL 18 class I 8 mA drive 1.20 1.34 1.47 ns

HSTL18D_II Differential HSTL 18 class II 0.89 1.00 1.11 ns

HSTL15_I HSTL_15 class I 4 mA drive, VCCIO = 1.5 V 1.67 1.83 1.99 ns

HSTL15D_I Differential HSTL 15 class I 4 mA drive 1.67 1.83 1.99 ns

SSTL33_I SSTL_3 class I, VCCIO = 3.3 V 1.12 1.17 1.21 ns

SSTL33_II SSTL_3 class II, VCCIO = 3.3 V 1.08 1.12 1.15 ns

SSTL33D_I Differential SSTL_3 class I 1.12 1.17 1.21 ns

SSTL33D_II Differential SSTL_3 class II 1.08 1.12 1.15 ns

SSTL25_I SSTL_2 class I 8 mA drive, VCCIO = 2.5 V 1.06 1.19 1.31 ns

SSTL25_II SSTL_2 class II 16 mA drive, VCCIO = 2.5 V 1.04 1.17 1.31 ns

SSTL25D_I Differential SSTL_2 class I 8 mA drive 1.06 1.19 1.31 ns

SSTL25D_II Differential SSTL_2 class II 16 mA drive 1.04 1.17 1.31 ns

SSTL18_I SSTL_1.8 class I, VCCIO = 1.8 V 0.70 0.84 0.97 ns

SSTL18_II SSTL_1.8 class II 8 mA drive, VCCIO = 1.8 V 0.70 0.84 0.97 ns

SSTL18D_I Differential SSTL_1.8 class I 0.70 0.84 0.97 ns

SSTL18D_II Differential SSTL_1.8 class II 8 mA drive 0.70 0.84 0.97 ns

SSTL15 SSTL_1.5, VCCIO = 1.5 V 1.22 1.35 1.48 ns

SSTL15D Differential SSTL_15 1.22 1.35 1.48 ns

LVTTL33_4mA LVTTL 4 mA drive, VCCIO = 3.3V 0.25 0.24 0.23 ns

LVTTL33_8mA LVTTL 8 mA drive, VCCIO = 3.3V –0.06 –0.06 –0.07 ns

LVTTL33_12mA LVTTL 12 mA drive, VCCIO = 3.3V –0.01 –0.02 –0.02 ns

LVTTL33_16mA LVTTL 16 mA drive, VCCIO = 3.3V –0.07 –0.07 –0.08 ns

LVTTL33_20mA LVTTL 20 mA drive, VCCIO = 3.3V –0.12 –0.13 –0.14 ns

LVCMOS33_4mA LVCMOS 3.3 4 mA drive, fast slew rate 0.25 0.24 0.23 ns

LVCMOS33_8mA LVCMOS 3.3 8 mA drive, fast slew rate –0.06 –0.06 –0.07 ns

LVCMOS33_12mA LVCMOS 3.3 12 mA drive, fast slew rate –0.01 –0.02 –0.02 ns

LVCMOS33_16mA LVCMOS 3.3 16 mA drive, fast slew rate –0.07 –0.07 –0.08 ns

LVCMOS33_20mA LVCMOS 3.3 20 mA drive, fast slew rate –0.12 –0.13 –0.14 ns

LVCMOS25_4mA LVCMOS 2.5 4 mA drive, fast slew rate 0.12 0.10 0.09 ns

LVCMOS25_8mA LVCMOS 2.5 8 mA drive, fast slew rate –0.05 –0.06 –0.07 ns

LVCMOS25_12mA LVCMOS 2.5 12 mA drive, fast slew rate 0.00 0.00 0.00 ns

LVCMOS25_16mA LVCMOS 2.5 16 mA drive, fast slew rate –0.12 –0.13 –0.14 ns

LVCMOS25_20mA LVCMOS 2.5 20 mA drive, fast slew rate –0.12 –0.13 –0.14 ns

LVCMOS18_4mA LVCMOS 1.8 4 mA drive, fast slew rate 0.11 0.12 0.14 ns

LVCMOS18_8mA LVCMOS 1.8 8 mA drive, fast slew rate 0.11 0.12 0.14 ns

LVCMOS18_12mA LVCMOS 1.8 12 mA drive, fast slew rate –0.04 –0.03 –0.03 ns

LVCMOS18_16mA LVCMOS 1.8 16 mA drive, fast slew rate –0.04 –0.03 –0.03 ns

LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 (Continued)
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units
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SERDES/PCS Block Latency
Table 3-8 describes the latency of each functional block in the transmitter and receiver. Latency is given in parallel 
clock cycles. Figure 3-12 shows the location of each block.

Table 3-8. SERDES/PCS Latency Breakdown

Figure 3-12. Transmitter and Receiver Latency Block Diagram

Item Description Min. Avg. Max. Fixed Bypass Units

Transmit Data Latency1

T1

FPGA Bridge - Gearing disabled with different clocks 1 3 5 — 1 word clk

FPGA Bridge - Gearing disabled with same clocks — — — 3 1 word clk

FPGA Bridge - Gearing enabled 1 3 5 — — word clk

T2 8b10b Encoder — — — 2 1 word clk

T3 SERDES Bridge transmit — — — 2 1 word clk

T4
Serializer: 8-bit mode — — — 15 + 1 — UI + ps

Serializer: 10-bit mode — — — 18 + 1 — UI + ps

T5
Pre-emphasis ON — — — 1 + 2 — UI + ps

Pre-emphasis OFF — — — 0 + 3 — UI + ps

Receive Data Latency2

R1
Equalization ON — — — 1 — UI + ps

Equalization OFF — — — 2 — UI + ps

R2
Deserializer: 8-bit mode — — — 10 + 3 — UI + ps

Deserializer: 10-bit mode — — — 12 + 3 — UI + ps

R3 SERDES Bridge receive — — — 2 — word clk

R4 Word alignment 3.1 — 4 — — word clk

R5 8b10b decoder — — — 1 — word clk

R6 Clock Tolerance Compensation 7 15 23 1 1 word clk

R7

FPGA Bridge - Gearing disabled with different clocks 1 3 5 — 1 word clk

FPGA Bridge - Gearing disabled with same clocks — — — 3 1 word clk

FPGA Bridge - Gearing enabled 1 3 5 — — word clk

1. 1 = –245 ps, 2 = +88 ps, 3 = +112 ps. 
2. 1 = +118 ps, 2 = +132 ps, 3 = +700 ps. 
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Figure 3-16. Jitter Transfer – 1.25 Gbps

Figure 3-17. Jitter Transfer – 622 Mbps
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Figure 3-18. XAUI Sinusoidal Jitter Tolerance Mask

Note: The sinusoidal jitter tolerance is measured with at least 0.37 UIpp of Deterministic
jitter (Dj) and the sum of Dj and Rj (random jitter) is at least 0.55 UIpp. Therefore, the 
sum of Dj, Rj and Sj (sinusoidal jitter) is at least 0.65 UIpp (Dj = 0.37, Rj = 0.18, Sj = 0.1).
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Gigabit Ethernet/Serial Rapid I/O Type 1/SGMII/CPRI LV E.12 Electrical and 
Timing Characteristics
AC and DC Characteristics
Table 3-17. Transmit

Table 3-18. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.10 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.24 UI

1. Rise and fall times measured with board trace, connector and approximately 2.5 pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 1.25 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 1.25 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 1.25 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
1, 2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.34 UI

JRX_RJ
1, 2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.26 UI

JRX_SJ
1, 2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.11 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.71 UI

TRX_EYE Receiver eye opening 0.29 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 1.25 Gbps.
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Switching Test Conditions
Figure 3-33 shows the output test load that is used for AC testing. The specific values for resistance, capacitance, 
voltage, and other test conditions are shown in Table 3-23. 

Figure 3-33. Output Test Load, LVTTL and LVCMOS Standards

Table 3-23. Test Fixture Required Components, Non-Terminated Interfaces

Test Condition R1 R2 CL Timing Ref. VT

LVTTL and other LVCMOS settings (L -> H, H -> L)   0 pF

LVCMOS 3.3 = 1.5V —

LVCMOS 2.5 = VCCIO/2 —

LVCMOS 1.8 = VCCIO/2 —

LVCMOS 1.5 = VCCIO/2 —

LVCMOS 1.2 = VCCIO/2 —

LVCMOS 2.5 I/O (Z -> H)  1M 0 pF VCCIO/2 —

LVCMOS 2.5 I/O (Z -> L) 1 M  0 pF VCCIO/2 VCCIO

LVCMOS 2.5 I/O (H -> Z)  100 0 pF VOH - 0.10 —

LVCMOS 2.5 I/O (L -> Z) 100  0 pF VOL + 0.10 VCCIO

Note: Output test conditions for all other interfaces are determined by the respective standards.

DUT 

VT

R1

R2

 

CL* 

Test Point

*CL Includes Test Fixture and Probe Capacitance
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-17EA ECP3-35EA

Pin Type 256 ftBGA 328 csBGA 484 fpBGA 256 ftBGA 484 fpBGA 672 fpBGA

Emulated Differential I/O per 
Bank

Bank 0 13 10 18 13 21 24

Bank 1 7 5 12 7 18 18

Bank 2 2 2 4 1 8 8

Bank 3 4 2 13 5 20 19

Bank 6 5 1 13 6 22 20

Bank 7 6 9 10 6 11 13

Bank 8 12 12 12 12 12 12

Highspeed Differential I/O per 
Bank

Bank 0 0 0 0 0 0 0

Bank 1 0 0 0 0 0 0

Bank 2 2 2 3 3 6 6

Bank 3 5 4 9 4 9 12

Bank 6 5 4 9 4 11 12

Bank 7 5 6 8 5 9 10

Bank 8 0 0 0 0 0 0

Total Single Ended/ Total 
Differential I/O per Bank

Bank 0 26/13 20/10 36/18 26/13 42/21 48/24

Bank 1 14/7 10/5 24/12 14/7 36/18 36/18

Bank 2 8/4 9/4 14/7 8/4 28/14 28/14

Bank 3 18/9 12/6 44/22 18/9 58/29 63/31

Bank 6 20/10 11/5 44/22 20/10 67/33 65/32

Bank 7 23/11 30/15 36/18 23/11 40/20 46/23

Bank 8 24/12 24/12 24/12 24/12 24/12 24/12

DDR Groups Bonded per 
Bank2

Bank 0 2 1 3 2 3 4

Bank 1 1 0 2 1 3 3

Bank 2 0 0 1 0 2 2

Bank 3 1 0 3 1 3 4

Bank 6 1 0 3 1 4 4

Bank 7 1 2 2 1 3 3

Configuration 
Bank 8 0 0 0 0 0 0

SERDES Quads 1 1 1 1 1 1

1. These pins must remain floating on the board.
2. Some DQS groups may not support DQS-12. Refer to the device pinout (.csv) file.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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For Further Information
A variety of technical notes for the LatticeECP3 family are available on the Lattice website at www.latticesemi.com.

• TN1169, LatticeECP3 sysCONFIG Usage Guide

• TN1176, LatticeECP3 SERDES/PCS Usage Guide

• TN1177, LatticeECP3 sysIO Usage Guide

• TN1178, LatticeECP3 sysCLOCK PLL/DLL Design and Usage Guide

• TN1179, LatticeECP3 Memory Usage Guide

• TN1180, LatticeECP3 High-Speed I/O Interface

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• TN1182, LatticeECP3 sysDSP Usage Guide

• TN1184, LatticeECP3 Soft Error Detection (SED) Usage Guide

• TN1189, LatticeECP3 Hardware Checklist 

• TN1215, LatticeECP2MS and LatticeECP2S Devices 

• TN1216, LatticeECP2/M and LatticeECP3 Dual Boot Feature Advanced Security Encryption Key Program-
ming Guide for LatticeECP3

• TN1222, LatticeECP3 Slave SPI Port User's Guide

For further information on interface standards refer to the following websites:

• JEDEC Standards (LVTTL, LVCMOS, SSTL, HSTL): www.jedec.org
• PCI: www.pcisig.com

LatticeECP3 Family Data Sheet
Supplemental Information

www.latticesemi.com/~/media/Documents/ApplicationNotes/AD/AdvancedSecurityEncryptionKeyProgrammingGuideforLatticeECP3LatticeECP2MSandLatticeECP2SDevices.PDF
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP2MandLatticeECP3DualBootFeature.PDF
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP2MandLatticeECP3DualBootFeature.PDF
www.latticesemi.com/dynamic/view_document.cfm?document_id=32318
www.latticesemi.com/dynamic/view_document.cfm?document_id=32319
www.latticesemi.com/dynamic/view_document.cfm?document_id=32320
www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
www.latticesemi.com/dynamic/view_document.cfm?document_id=32322
www.latticesemi.com/dynamic/view_document.cfm?document_id=32323
www.latticesemi.com/dynamic/view_document.cfm?document_id=32324
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP3SlaveSPIPortUsersGuide.pdf
www.pcisig.com
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.jedec.org
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Updated Frequency to 150 Mbps in Table 3-11 Periodic Receiver Jitter 
Tolerance Specification

December 2010 01.7EA Multiple Data sheet made final. Removed “preliminary” headings.

Removed data for 70E and 95E devices. A separate data sheet is avail-
able for these specific devices.

Updated for Lattice Diamond design software.

Introduction Corrected number of user I/Os

Architecture Corrected the package type in Table 2-14 Available SERDES Quad per 
LatticeECP3 Devices. 

Updated description of General Purpose PLL

Added additional information in the Flexible Quad SERDES Architecture 
section.

Added footnotes and corrected the information in Table 2-16 Selectable 
master Clock (MCCLK) Frequencies During Configuration (Nominal).

Updated Figure 2-16, Per Region Secondary Clock Selection.

Updated description for On-Chip Programmable Termination.

Added information about number of rows of DSP slices.

Updated footnote 2 for Table 2-12, On-Chip Termination Options for 
Input Modes.

Updated information for sysIO buffer pairs.

Corrected minimum number of General Purpose PLLs (was 4, now 2).

DC and Switching 
Characteristics

Regenerated sysCONFIG Port Timing figure.

Added tW (clock pulse width) in External Switching Characteristics 
table.

Corrected units, revised and added data, and corrected footnote 1 in 
External Switching Characteristics table.

Added Jitter Transfer figures in SERDES External Reference Clock sec-
tion.

Corrected capacitance information in the DC Electrical Characteristics 
table.

Corrected data in the Register-to-Register Performance table.

Corrected GDDR Parameter name HOGDDR.

Corrected RSDS25 -7 data in Family Timing Adders table.

Added footnotes 10-12 to DDR data information in the External Switch-
ing Characteristics table.

Corrected titles for Figures 3-7 (DDR/DDR2/DDR3 Parameters) and 
3-8 (Generic DDR/DDRX2 Parameters).

Updated titles for Figures 3-5 (MLVDS25 (Multipoint Low Voltage Differ-
ential Signaling)) and 3-6 (Generic DDRX1/DDRX2 (With Clock and 
Data Edges Aligned)).

Updated Supply Current table.

Added GDDR interface information to the External Switching and Char-
acteristics table.

Added footnote to sysIO Recommended Operating Conditions table.

Added footnote to LVDS25 table.

Corrected DDR section footnotes and references.

Corrected Hot Socketing support from “top and bottom banks” to “top 
and bottom I/O pins”.

Pinout Information Updated description for VTTx.

Date Version Section Change Summary


